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Getting Started in Cataloging

Polaris Cataloging provides options for adding, modifying, deleting, and managing
cataloging records.

See also:

» Cataloging Options on the Shortcut Bar

» Cataloging Records
» Methods for Adding New Records
e Finding Cataloging Records

Polaris Cataloging Overview

Polaris Cataloging records provide the core data upon which all other functions in
Polaris depend. Bibliographic and item records are used throughout the Polaris staff
client, and they determine the PAC display. Authority records provide standardized
access points to indexes and headings in the public catalog. Community records
provide information about community organizations. Promotion records enable the
library to promote titles, Web sites, community organizations, and events in Polaris
PowerPAC.

To streamline your cataloging tasks, Polaris provides tools such as: import profiles for
efficiently importing records; bulk creation of item records; bulk change for bibliographic
and item records; remote database searching for easy copy cataloging; automatic
remote authority control; bibliographic record replacement; and templates to ensure
record consistency. Quick navigation between linked records also enhances efficiency.

When you need to create original MARC records, you select from dialog boxes that
present the appropriate values based on previous selections. And, you can immediately
preview how the title will appear in the PAC.

Your Polaris Administrator can use a variety of options to manage cataloging records
and specify how titles are displayed in the PAC. See the Cataloging Administration PDF
Guide.

For more information on the features and functions available in Polaris Cataloging, see
these topics:
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Getting Started in Cataloging

Overview of Polaris cataloging records; methods for creating new records; how to
search for and display bibliographic, authority, and item records.

Creating, Copying, and Editing MARC Records

Creating original MARC records; copying MARC records from remote sources;
editing MARC records.

Using Cataloging Templates

Using templates to streamline your cataloging processes.

Setting Up Import Profiles and Importing Records

Setting up import profiles; importing records into your Polaris catalog.

Checking Cataloging Records

Checking records for headings, MARC format, and duplicates.

Maintaining Item Records

Creating item records and preparing items for circulation; printing labels.

Working with Multiple Cataloging Records

Grouping related cataloging records in record sets for bulk processing.

Maintaining Your Catalog

Maintaining your catalog; exporting records; identifying unlinked records; deleting
records; and using reports to identify problems.

Managing Promotions

Creating and editing promotion records to feature resources in PAC.

Cataloging Bound-With Materials

When cataloging pamphlets or other materials that have individual titles and
individual bibliographic records, but are bound together in physical volumes,
libraries can group bibliographic records together.

Setting Up Labels

Setting up labels; customizing labels; defining label content; specifying label
printers.

Generating and Copying Content Carousel Code
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Using the Carousel Toolkit (available by separate license) to copy code snippets
for content carousels from the Polaris ILS to external web sites.

Type of Material Codes (TOMS)

Lists the Type of Material Codes (TOMs); the MARC codes required to produce
specific TOMs; order of precedence to determine primary TOM.

Cataloging Shortcut Keys

List of Cataloging shortcut keys.

Cataloging Options on the Shortcut Bar

From the Polaris Shortcut Bar, you can create new cataloging records, find existing
records, import or export records, and initiate automatic processing of cataloging
records. Specific permissions are required for creating, modifying, deleting, and
processing cataloging records. Course Reserves, Community Records, Promotions,
Campaigns, and Carousel Toolkit are available if your library has licenses for these
products. For information on the permissions required to do cataloging tasks, see
Cataloging Permissions.

Tip:
You can also click the blue orb to expand the Cataloging toolbar. Then,
click the icons to open the Find Tool and search for existing Cataloging

records. For example, click | E1 |to search for an existing bibliographic
record.

See also:

» Creating New Cataloging Records

» Accessing Existing Cataloging Records

» Start Cataloging Records Processing

Creating New Cataloging Records

Tip:
In the New dialog box, select Cataloging Objects in the View box to list
only Cataloging records.
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To create a new Cataloging record, select File > New, press CTRL+N or click . The
New dialog box appears. If the record type has templates defined, you can select
Existing Template and choose a template to create a new record. If you are creating
several records of the same type using the same template, you can select an existing
template, and then click Make session default. When you create the next record of the
same type, the template you selected will be used. If the record type does not have
templates defined, or you want to create a new record without a template, click OK. See
Methods for Adding New Records.

Accessing Existing Cataloging Records

Select Cataloging and select a menu option. The Find Tool opens for the selected
record type. See Finding Cataloging Records.

Start Cataloging Records Processing

Select Utilities > Cataloging Processing. The Cataloging Processing submenu displays
the processing utilities, such as purging cataloging records and managing the bulk
change queue. See Cleaning Up the Catalog

File Acquisitions Serials Cataloging Patron Services Circulation  Administration | Utilities | Window Help
A po) [PO FrlTn < ﬁ Reports and Notices E
D @ =4 |:|. §l g %eﬁ = = E@
o Importing 3

Cataloging Processing 3 Purge Cataleging Records
Quick-circ ltem Records Bibliographic Bulk Change Queue

Acquisitions Processing 3 Autherity Create Links Queue

Label Manager Authority Update Links Queue

Mailing Label Manager Create Unlinked Bibliographic Record Set

Credit Card Payments Manager Create Unlinked Authority Record Set

URL Detective

Web Browser

Carousel Toolkit

Accessing the Carousel Toolkit

If your library has a license for this product, the Carousel Toolkit is available from the
Polaris Shortcut Bar. For more information, see Carousel Toolkit.
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Cataloging Records

Polaris Cataloging uses bibliographic records, authority records, item records, and
templates. Bibliographic records can be linked to multiple item records and multiple
authority records. Authority records can be linked to multiple bibliographic records and
multiple authority records, but they are not linked to item records. An item record is
linked to a single bibliographic record, and multiple item records can be linked to the
same bibliographic record. Item records can also be linked to other item records.

Depending on your library’s Polaris licenses, other selections may be available on the
Cataloging menu. If your library has a license for Polaris Feature It, you can use
Promotion records to feature titles, events, or community records in Polaris PowerPAC.
If your library has a license for Polaris Community Profiles, you can create community
records in Cataloging and then designate the organization representative who can
update the record from the PAC.

See also:

» Bibliographic Records

» |tem Records
e Authority Records

o Cataloging Templates

e Record Sets
e Promotion Records

o Community Records

Bibliographic Records

Every title in the library’s catalog is represented by a bibliographic record saved in the
Polaris database in MARC 21 Format for Bibliographic Data. Each bibliographic record is
identified by a unique control number recorded in the 001 tag. You can add bibliographic
records for new titles by importing records, copy cataloging, or original cataloging. See
Methods for Adding New Records. A bibliographic record must have a Leader and an
008 tag to be saved in the Polaris database.

When you save a bibliographic record, it is checked for the correct MARC format and for
possible duplicate records already in the catalog. When duplicate bibliographic records
are found, you can automatically replace them. You can also replace records that were
not identified as duplicates. In addition, headings are checked against authority records
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to maintain consistent authority control. See Checking Authority Headings. You can
create linked item records from the Tools menu on the Bibliographic Record workform.
See Creating Item Records.

i Bibliographic Record 406869 - MARC21 - Polaris = B
File Edit View Links Tools Help
hEH&-X 2 JM e & @
-E Control number: 406869 Owner: | QA-RIGEL w | Items: | 328 Record status: | Final
8 Title: Harry Potter and the Chamber of Secrets DoV BAC Lt
] [ Do not overlay Host
% Tag Ind Data ~
el | o= cam 22 a4500
= 001 406869
% 005 20090316111835.0
[ 8 98002851999 nyua | 000 1engd
(=) 1 ta 98046370 JAC
Q 2 +39780439064866 -Tc$22 99
"_6 2 +a0439064872 (pbk) - fc $8.99
] 020 1a0439064864 1c$22 99
m 035 TaAGE-9608
050 00 1aPZ7.R79681bHar 1999
082 00 ta[Ficlt221
osz thRow
4 osg ThRow
il 100 1 TaRowling, J. K.
245 10 TaHarry Potter and the Chamber of Secrets ffcby J. K. Rowling ; illustrations by Mary Grandpre.
260 TaNew York :TbArthur A Levine Books/Scholastic Press,fcc1999.
300 Taviil, 341 p. ;Tc24 cm.
500 TaSequel to: Harry Potter and the sorcerer's stone.
500 TaSize varies.
520 TaWhen the Chamber of Secrets is opened again at the Hogswart School for Witchcraft and Wizardry, second-year student Harry
Potter finds himself in danger from a dark power that has once more been released on the school.
650 0 TaWizardstvFiction.
650 D TaMagictvFiction. v
For Help, press F1 MNUM

Viewing Circulation Statistics and Linked Item Records

Bibliographic records may be linked to multiple item records, each representing a
distinct physical item. The total number of linked items is displayed in the Bibliographic
Record workform header. To view the circulation statistics for all items linked to the
bibliographic record, select Tools > Show Usage Statistics or press CTRL+R from the
Bibliographic Record workform. You can also select a bibliographic record in the Find
Tool results list, right-click and select Preview. The preview window'’s top pane displays
the brief bibliographic view, the middle pane displays the usage statistics for linked
items, and the bottom pane displays the list of linked items.

The usage statistics in the middle pane include the total number of items and
circulations for all branches, and a list of the items and circulations by branch. The
popularity of the title is displayed as High, Medium, or Low, based on the number of

© 2023 Innovative (Part of Clarivate)
Page 6



Cataloging Guide

circulations and holds. The titles with a popularity of High have circulated and had holds
placed on the linked items within the last 120 days. The titles with a popularity of
Medium have linked items that either circulated or had holds placed on them within the
last 120 days. The titles that have a popularity ranking of Low have not had any linked
items circulated or held within the last 120 days.

All the individual items linked to this bibliographic record are displayed in a list in the
bottom pane of the window. You can do the following in the list of items:

e To sort the list, click on a column header.
e To open an item in the Item Record workform, double-click.

» To perform actions on a single item record, right-click and select an option from
the menu.

» To perform actions on multiple item records, multi-select the items, right-click, and
select an option from the menu.

Example:

Select the linked item records in the list, right-click, and select Ad hoc
Bulk Change. The Item Bulk Change dialog box opens. See Changing
Multiple Item Records.
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Preview the Title Display in the PAC

Tips:

Click to display the PAC view. A Polaris Administration profile can
be set to always open the Bibliographic Record workform to the PAC view.

Select View > PAC to preview the title’s bibliographic data display in Polaris PowerPAC.
The view of the PAC from the Bibliographic Record is the same as it appears for your
patrons, including all the customization you have set up for your PAC. Some actions that
are possible from the PAC may not be possible from this view, such as searching for
other records or actions that require the PAC user to log in. Links to external sites open
in a new browser window. Web links are active from the PAC view if the record has an
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856 tag. For more information on how Web links are displayed in the PAC, see Web
Links Display in the PAC.

If you have not resized the bibliographic record workform from its default size, the PAC
view appears as it would on a tablet device. If you make the workform larger, the display
may change to the way it would appear on a desktop computer. That is, action buttons
such as Availability and Full Display may move from below the title metadata to the
right side of the data. The example shows the display at the default workform size.

Note:

The title information that is displayed in the PAC can be customized in
Polaris Administration. See the Public Access Administration PDF Guide,
Configuring the PowerPAC Title Display..

ET Biblingraphic Recard 406850 - PAC - Falaris - olEN
Fis Edit Wiew Linka Teclh Hilg

D@HE- XX z2ae Bz Mo & F

= ondrod e AW5A5H e | QAFDLARES 55 fova) v leen |16 Aeoord staiem | Fnal

= e ey Patier andl e Thardser oF Secrets et nPAC

1B reat comrlary

~ | | Location: | Coraunty Lbrany (008] ~|

1. Harry Potter and the Chamber of Secrets
Dy Randing K

Mew ok : Arthur & Levine BooksyScholaslic Press, C19469.
will, 241 p.; 24 cm.

|__' I H | Fict Fow

Web Links Display in the PAC

The clickable Web link text that displays in the PAC full and brief displays for a title is
determined by the subfields in the 856 tag as follows:
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» 856Su - URL - If the bibliographic record has an 856Su without a Sy, $3, or $z, the
default text Web Link is displayed in PowerPAC instead of the URL.

|| g56 4 fubttp:fgsarat . galagraup. comiserviatie Books Ys1e=22 EdneNum=CoCH40EE 00008 g=rysl_ca_sa ||
| | . N
wlE b | 1. The Gale encyclopedia of genetic disorders AVAILABILITY
| DL
i F 2001
&R El FULL DISPLAY
The Gale encyclopedia of genetic disorders / Stacey L, Blachford,
associate editor, E PLACE REQUEST
I I l I ite: Detroit, Ml : Gale Group, 2001.
M ft ty Includes electronic book Add to My List
2001
r_’.l Web Limk
Includes bibliographical references and index.
1345 p. till; 29 e
4 (of 5)
R 616.042 Gal
Book

» 8568y - Link Text - If the bibliographic record has an 8563y, the text in the first
occurrence of this tag is used for the Web link display instead of the URL in the
8563u.

B56 1 taBibliographic recond dsgkayfuhnp: Sy netlioeany. comiurkso. &S prac ion=summanySv=18bookid = 135204 s
downicadaike audio book accessibia through the World Wida Wes; dick for informadion

8. The accidental tourist [electronic resource] AVAILABILITY
by Tyler, Anne
n FULL DISPLAY
.. The gecidental tourist [electronic resource] f by Anne Tyler, ..,
it te- Prince Frederick, MD : Recorded Books ; [Boulder, Colo E PLACE REQUEST
Made available electronically by] MetLibrary, 2005
Lnabrdgad Add to My List

Vel Bibliographic record display C4 - A downloadable audio book
accessible through the world wide web; click for information

T L RL I LT Ty T THIIe L.|‘_|.Lc'ﬂ, T e

Online Resource

see reviews,/add a
Teviaw
o 3B reviews [
Hddd )

» 856$3 - Material Specified - If the bibliographic record does not have an 8563y,
but it does have an 85683, the text in the first occurrence of this tag is used for the
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Web link display instead of the URL in the 8568u.

PSP unlisiar description Duhtp: ey loc. gow'catdin descripion’mb0 3 1720032035104 hirml ||

[;5:

BRILLE AND
ETRATESIES

1. Little League drills and strategies : imaginative practice driffs to
mprove skills and attitude
by Mcintash, Med

2003

a0OQn

Little League drills and sirategies | imaginative practics drills ta improve skills and attitude | Med
Meiricsh and Rich Add to My List

Chicago : Conternporary Books, c2003

» 85698z - Public Note - If the bibliographic record has an 856Su with an 8568z, the
default text Web Link is the clickable link, and the text in subfield z appears after

the link.
[ 856 tuhitp:/fpaimsprings.lib.ovardrive. com/ContentDetails htmA0=E406ATF D-108F -4.328-226 E-BA8AASSD DG Cick hera ||
1. Darker after midnight [electronic resource] : a midnight breed E FULL DISPLAY
navel
by Adrian, Lara
te, Mew York ; Rapdom House, 2012,
3 e oLt
1 OMMETEToTe
M2 | ser .10
Uger rating
\SEE &Y
Rghe ar revien
'ID‘re.-'.:.sws
(Fededede)
oo

Item Records

An item record represents a unique physical or electronic copy of the bibliographic
record title to which it is linked. Although information from the linked bibliographic
record appears in the ltem Record workform’s header, item records do not contain
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MARC 21 data. Several item records, each representing a separate item, may be linked
to the same bibliographic record. Item records are not necessary for ebook titles if the
ebook vendor does not integrate with Polaris Circulation.

Note:

If you select File > New > Item Record from the Polaris Shortcut Bar, the
New Item Record Options dialog box appears. Use this dialog box to
create multiple items linked to the same bibliographic record. See
Creating Item Records. If you are creating one record, you can click OK to
go to the Item Record workform.

Tip:
On the Bibliographic Record workform, select Links, Item Records, press

CTRL+T or click | ¥* | to see all the other item records that are linked to
the same bibliographic record.

By default, the initial view of the Item Record workform depends on how you open the
record. When you are creating a new item record, the workform opens to the Cataloging
view. When you open an item record from a purchase order line item or invoice line item,
the workform opens to the Source and Acquisition view. In all other cases, the workform
opens to the Circulation view. However, you can set a Polaris Administration profile so
that the Item Record workform always opens to a particular view.
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L5

Item Record 2049753 - Circulation - Polaris

File Edit View Links

Tools  Help

For Help, press F1

.c, Barcode: 0004300346626 Record status: | Final
8 Title: Harry Potter and the Chamber of Secrets
Q Author: Rowling, 1. K.
L
Q: Callnumber: | va Fict Row
E Owner: Amsterdam Free Library (br)
o}
ﬁ Assigned: Amsterdam Free Library (AMS)
& Collection: {(Mone)
|:| Due date: Current borrower:
[ﬂ Check-out date: Loaning branch:
4
Renewals taken: | 0 Limit: | 1
Held for patron:
Last renew date: Held at:
Criginal due date:
Last location Last use
Chedk-n at: Last borrower:
Loaning branch:
Date:
WiksfUser: Last drculated:

NDEHE-X DY I E~rRBI] & @

L EContent
Find
Parent item:
Price: 25,99
v |  Shelflocation: {(Mone)
w Temporary location:
v | Circulation status: Withdrawn

In-transit/Transferred

From:

Sent:

To:

Received:

1004300008449

Amsterdam Free Library

£/12/2007 4:50: 13 PM

[ Mon-dreulating [ pisplay in PAC
Bib control number: | 406359
Item control number: 2049753

Issue control no.:

v

MNUM

Authority Records

Polaris uses the MARC 21 Format for Authority Data for authority records, which are
linked to bibliographic records or other authority records. When you change an authority
record, the change is applied to all linked records. Authority records are identified by a
unique control number recorded in the 001 tag of the authority record. Like bibliographic
records, authority records are subject to MARC 21 validation (tag checking) to help you
maintain correct and consistent records. For more information, see Create a new

authority record.
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heHds&s X o Bix) 8 & g 9

Control number: 938808 Record status: | Final

Heading: Rowling, J. K.

Tag Ind Data

DR cz 22 n 4500
001 938808

003 PolarisTest

005 20130729091810.0

008 971028n| azannaabn |a aaa
010 Tan 97108433

035 ta(0CoLC)ocald490878
035 ta(DLC)n 97108433
035 1213209316

035 1213220602

035 Ta(PolarisTest)938220
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S
Q
QL
2
P
=
S
<
S
<

faDLCtbengterdatcDLCIdUPBIdIANCCSTdDLCTIdOCIEdOCoLCTdNNCIdDLCTdInUdIUTdIENTdOrUtdUPBIdIEN
1dOCoLCTdDLCTdUPBIdWal
+aPRE068.093
TaRowling, J. K.
TaRowling, Joanne K.
TaRowling, Jo
faRoling, G'e. Ke
taRowlingova, Joanne K.

For Help, press F1

Automatic Authority Control Using a Remote Database

If you have a subscription to Polaris ZMARC, you can find and save a new authority
record from ZMARC when you save a bibliographic record and no matching authority
record is found in the local database. The new authority record is saved and the
bibliographic record is linked. See ZMARC Remote Authority Control.

Authorities Weekly Update Service

If you have a subscription to Polaris Authorities Weekly, Innovative Interfaces installs a
job at your site that tracks your authority records. When updates are issued by the
Library of Congress, the system checks the records to see if any match the authority
records your library has. If matches are found, and there are updates, an e-mail message
informs your administrator and provides the location of the file containing the updated
authorities. You can then import the authority records and overlay your existing ones
using the import profile Authority Update Import. See Setting Up Import Profiles and
Importing Records.
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Cataloging Templates

Cataloging templates help your library maintain consistent records and reduce the
number of keystrokes required to create new cataloging records. You can create
bibliographic, authority, and item templates by manually entering data or by saving
existing records as templates, and then editing the data. See Using Cataloging
Templates for more information.

Record Sets

Tip:

You can bulk change item records from lists, such as the Find Tool search
results or linked list boxes, without putting the items in a record set. See
Changing Multiple Item Records.

Record sets group related records together so you can retrieve them in one step.
Bibliographic and item records in a record set can be changed or processed in one step.
For example, you can gather bibliographic records in a record set, and then use the bulk
change process to make the same changes to all the records in one step. You can
create record sets of bibliographic, item, or authority records, but you cannot have
different types of records in one record set. See Working With Multiple Records.

When you import bibliographic or authority records, you can specify a destination record
set to group them. This allows for more efficient retrieval and manipulation of the
imported records. See Set import options for record sets.
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DﬁE%]X BR = EY

Name: | Camping Owner: |Long Lake Library {br) v| Record type: | Bibliographic

Mote: Number of records: | 17

QW= -

Link... Publi...  Call Number Control ... Status

The boy's book of backyard camping Macfarlan, Allan A.

The budget backpacker : how to select or make,... Zakreski, L. A. Book
Camp David : peacemaking and politics Quandt, William B. Book
Camp KeeWee's secret weapon Schulman, Janet. Book
Camp out Stine, R. L. Book
Camping Hundal, Mancy, 1... Book
Camping : a complete guide to why, how, and w... Carra, Andrew . Book
Canoe camping Evans, George He... Book

088.76 2 361104 Final ...
327.73Q 34330 Final ...
JE Fict Sch 3931 Final ...
Fict 5t YA 327980 Final ...
jP Fict Hun 513396 Final ...
796,54 C 1870 Final ...
797.12E92c... 118 Final ...
797.122 Dav 6672 Final ...
j821.085 73545 Final ...
LaF 687227 Final ...
1Fict Con 2869 Final ...
685.535 6566 Final ...
Fict 359940 Final ...
796.54C 10381 Final ...
425C92 991 Final ...

The complete wilderness paddler Davidson, James ...  Book
Fives, sixes and sevens Stephenson, Marj... Book
Grin and bear it LaFoy, Leslie. Book
Hail, hail, Camp Timberwood Conford, Ellen. Book
How to build a comfortable campsite Sherwood, Marth...  Book
Just once Christian, Mary Bl... Book
Light weight camping equipment and how to mak... Cunningham, Gerry.  Book
The Random House handbook Crews, Frederick C.  Book
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For Help, press F1 17 of 17 record(s) retrieved

Promotion Records

If your library has a license for Polaris Feature It, Promotion records are used to feature
titles, events, or community records in Polaris PowerPAC. Staff members select the
featured resources and specify the conditions under which the resources are featured.
The library can specify the materials in the library’s collection, Web sites, community
organizations, events, and services. For more information, see Creating and Editing
Promotion Records.
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Community Records

If your library has purchased Polaris Community Profiles, a separately licensed product,
a staff member with the appropriate permissions can create or edit a community record
using the Community Record workform. After the community record is created, a staff
member can designate a patron as a community representative who can update and
modify the record from Polaris PowerPAC.
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Methods for Adding New Records

You can add bibliographic and authority records to the Polaris catalog database by
manually entering original records using the MARC Editor, importing records from other
sources, and copying records from remote databases. In most libraries, original
cataloging is done infrequently. Instead, catalog records are usually converted from
other library automation systems, produced by library vendors and conversion services,
imported, or copied from other sources.

Polaris also provides multiple methods for creating item records. You can quickly create
multiple items for copies of the same title by entering information common to all the
items, and then entering the branch and collection for each copy. If you are creating a
single item record, you can enter the information on the Item Record workform. In either
case, whether you are creating a single or multiple item records, you can use an item
record template. In addition, item records can be created automatically by importing
bibliographic records with embedded holdings.

See also:

e Original Cataloging

e Importing Records
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Copying MARC Records from Other Sources

Creating Preliminary Bib Records in Acquisitions

Creating Multiple Items for a Single Title

Automatic Remote Authority Control
Creating Digital-Collection Bibliographic Records in Polaris Fusion

Original Cataloging

Polaris has several tools to make original cataloging faster and easier. With the MARC
Editor, you can select data from lists, check the MARC format, enter international
characters, and use macros to automatically enter standard information. In addition, you
can use templates that have default cataloging data already filled in. For more
information, see Creating MARC Records.

Importing Records

Importing is the process of moving multiple MARC 21-formatted records into the Polaris
database from an outside source. You can import bibliographic and authority records,
and item records can be created from embedded holdings data in 852 tags (or other
locally-defined tags, such as the 949 tag) in the imported bibliographic records. For
more information, see Setting Up Import Profiles and Importing Records.

Copying MARC Records from Other Sources

You can modify an existing record in Polaris, or you can display and copy bibliographic
and authority records from other sources. Such sources may be other libraries,
suppliers, or cataloging services that make their catalog records available at no cost or
for a fee. If you subscribe to ZMARC, you can search for and save bibliographic or
authority records from the ZMARC database. See Copying MARC records.

Creating Preliminary Bib Records in Acquisitions

You can create brief bibliographic records by typing the bibliographic information in a
purchase order line item, or by pulling in title information from a supplier’'s database
using Titles to Go. See the Acquisitions PDF Guide, Ordering topic.
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Page 19



Cataloging Guide

Creating Multiple Items for a Single Title

You can create multiple item records linked to the same bibliographic record using the
New Item Record Options dialog box where you specify the distribution information for
each item. See Create multiple item records for a single title.

Automatic Remote Authority Control

If your library has a subscription to a remote database of authority records, the remote
database is automatically searched when no matching authority record is found. The
new authority record is saved in the database and linked to the new bibliographic
records. For more information, see the Cataloging Administration PDF Guide, Managing
Authority Control..

Creating Digital-Collection Bibliographic Records in Polaris Fusion

Records created in Polaris Fusion are automatically saved as bibliographic records in
the Polaris database with a type of material of digital collection. For more information,
see Polaris Fusion online Help.

Finding Cataloging Records

You can use the Polaris Find Tool to search your library’s catalog, catalogs of other
libraries using Polaris, catalogs of remote libraries that do not use Polaris, and other
remote databases. When you search for bibliographic records in languages other than
English, you can enter diacritics and special characters. If you have a subscription to
ZMARC, you can also search the ZMARC records directly from Polaris. MARC records
from these outside sources can be previewed and then saved to the Polaris database.

Important:
Before you can search remote databases from the Polaris Find Tool, your
Polaris administrator must set up the remote databases as targets.

When you do a search, the records are displayed in the results list, or if you selected
Count Only, a count of the matching records is displayed. You can select a Sort

by option to sort the records so that they display in a specified order. From the results
list, you can open the record in the appropriate workform, or you can right-click the
record and perform other actions from the context menu. The results list can be sorted
and printed to create a quick report. You can also send the records to a record set from
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the Find Tool, with or without displaying them in the results list. For basic information
about using the Find Tool, see Finding Polaris Records.

See also:

e Searching Tips

» Shortcut Keys to Find Bibliographic and Item Records

» Viewing Serial ltem Records in the Polaris Find Tool

» Access Points for Cataloging Records

e Searching for Items or Bib Records by RFID Tag

» Sorting the Results List

» Automatic Suggestions for Keyword & Phrase Searches

» Linking Between Records

» Find Cataloging Records in Your Library’'s Database

» Preview Bibliographic Records from the Find Tool

Searching Tips

You can reduce typing by using an implicitly truncated search. For example, a title
search for “bulletin” could be done using the following string: bulle. You have the option
to use the wild card character * at the beginning and end of a search string. For
example, an author search for Isaac Asimov could be done by inputting: Asimov*. The
results would contain all instances of Asimov as an author in the catalog.

Note:

When you do a phrase or keyword search for a title that includes an
ampersand (&), the search treats the ampersand the same as the word
“and”. The ampersand and the word “and” are not interchangeable for
exact match or browse searches.

Ignore Initial Articles in Titles

If the Use Initial Articles checkbox is checked, the initial article in a title is ignored or
“stripped out” if that article is defined in the Initial Articles table in Polaris
Administration. You can clear the Use Initial Articles Table checkbox to help find
records where the non-filing indicators are set improperly.

The Use Initial Articles checkbox is active only when the search type is Exact match
(either implicitly or explicitly truncated), and you are searching for the following records:

© 2023 Innovative (Part of Clarivate)
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Authority Records (Heading, Tracing/Reference)
Bibliographic Records (Title and Series)

Serials Check In Records (Title)

Claims (Title) (both for Acquisitions and Serial versions)
Course Reserve Records (Title)

Hold Requests (Title)

ILL Requests (Title)

Invoice Line Items (Title)

Issue Records (Title)

Item Records (Title and Series)

Part Records (Title)

Purchase Order Line Items (Title)

Reserve Item Records (Title)

Route Lists (Title)

Selection List Line Items (Title)

Serial Holdings Records (Title)

Subscription Records (Title)

Shortcut Keys to Find Bibliographic and Item Records

 Bibliographic Records - F12

e |tem Records - Ctrl+Alt+F9

For a list of other shortcut keys, see Cataloging Shortcut Keys.

Viewing Serial Item Records in the Polaris Find Tool

© 2023 Innovative (Part of Clarivate)
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From anywhere in the Polaris application, you can use the following shortcut keys to
bring up the Find Tool to search for cataloging records.

When you search for serial item records, you may need to expand the Title column in the
Polaris Find Tool results list to see the serial item’s designation because it is appended
to the title. You can drag the bottom right corner of the window, then drag the
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Title column border right to expand it. The serial item’s designation is displayed at the
end of the title.
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Access Points for Cataloging Records

Tip:

Searching a remote database for bibliographic records requires the
access point to have a standard Bib-1 Use Attribute, which are not defined
for some access points, such as UPC. If you are searching a remote
database for bibliographic records by UPC, select the access point
Standard system number, and enter the UPC barcode number.

The Search by box on the Find Tool contains index criteria specific to the type of record
you want to find. The available search types depend on what is selected in the By box.
You can narrow your search using a Limit By option and entering a limit by value.

You can customize the Find Tool with your preference for searching by setting up your
search for a specific type of record, and then selecting Options > Save as User Default.
See Customize the Find Tool by user.

Searching for Items or Bib Records by RFID Tag

The option to search by RFID tag is located under the Tools menu. When RFID Read
Tag is selected, the Search by selection is set to Barcode automatically. You can also
search for the linked bibliographic record by scanning the RFID tag. Select Tools, RFID
Read Tag and scan the tag using the RFID reader. The item record is displayed in the
Find Tool results.
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Sorting the Results List

You can select a Sort by option to sort the results before they are displayed. The Sort by
options depend on the type of record selected. For example, you could search for
bibliographic records by subject and sort by Title, then Author, then Type of Material.
Sorting options can also be saved as a user default.

Automatic Suggestions for Keyword & Phrase Searches

As you type a keyword or phrase for a bibliographic, item, or authority record, suggested
titles or headings appear if the Auto-suggest feature enabled Cataloging parameter is
set to Yes in Polaris Administration. Select one of the suggestions to see the matching
records. You can turn off automatic suggestions by clicking on Hide Suggestions. To

show suggestions when they are hidden, click on the right side of the text entry
box.

Linking Between Records

Certain types of cataloging records are linked in Polaris. For example, item records are
always linked to a bibliographic record. You can easily navigate from a record to its
linked records by selecting Links from a workform menu, or from the right-click menu in
a list of records.

Find Cataloging Records in Your Library’s Database

To find and list bibliographic records, item records, authority records, templates, or
record sets in your local database:

Note:
The available tabs in the Find Tool depend on the type of record selected.

Tip:
To search for bibliographic records from anywhere in the Polaris
application, press F12. To search for item records, press Ctrl+Alt+F9.

1. From the Polaris Shortcut Bar, select Cataloging, or press ALT+C to display the
Cataloging menu.

2. Select arecord type from the Cataloging menu.

The Polaris Find Tool appears.

© 2023 Innovative (Part of Clarivate)
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Tip:
You can tab from field to field in the Find Tool.

You can change the type of record in the Object box.

3. Select the search access point in the Search By box.

Tip:

If you are searching for a bibliographic record, you can search for a
10-digit or 13-digit ISBN. You can also search by the Other Standard
Identifier (which can be a UPC code or stock number). The Other
Standard Identifier may be used when searching for non-print items
that do not have an ISBN.

4. Select the search type in the Type box:

To find anything that begins with the contents of the For box, select Exact
match (implicitly truncated).

To find anything that has exactly the contents of the For box, select Exact
match (explicitly truncated).

To open an index that begins with the contents of the For box, select
Browse.

To find any occurrence of the contents in the For box, select Keyword
search.

To find the entries in the For box adjacent to each other in the data, and in
order, select Phrase search.

5. To sort the search results, select an option in the Sort by box. Sort is not available
in Browse searches.

Tip:
If you are doing a keyword or phrase search for a bibliographic or
authority record, you may see automatic suggestions as you type.

6. Type your search text in the For box.

7. To limit your search results, select an option in the Limit by box, and either select a
value or type it in the Value box. Some Limit by options have pre-set selections in
the Value box. For example, if you select Language, a list of languages appears in
the Value box. If you select Author, you type the author's name in the Value box.
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If you would typically search for this type of record using the same search criteria,
select Options > User Default to save your search options. To set the option back
to the system default, select Options > Revert to System Default.

Note:

Limit by values selected from a drop-down list are saved in the user
default, but free-text values are not saved. For example, if the Limit
by selection is Subject and you enter history in the Values box, the

value is not saved.

Tip:
If you just want a count of the records without seeing them in a list,
click Count Only.

Click Search, or press Enter or ALT+S.

A list of records matching your search criteria appears at the bottom of the Find
Tool (unless you selected Count Only). You can use the scroll bar to scroll through
the list of results, or use the up and down arrows on your keyboard.

Double-click the record to open the record in its workform, or right-click and
choose an option from the context menu. Depending on the record type, you can
perform various actions on the record without opening it in the workform.

Related Information

Setting limits on the number of records returned - Set Find Tool Results Limits

Searching databases other than your library’s database - Searching Remote Data-
bases

Searching using an SQL query - Setting Up SQL Searches

Using the Power Search option - Doing Power Searches

Using scoping to narrow your search - Scoping Searches for Bibs and Items

Preview Bibliographic Records from the Find Tool

To preview bibliographic records from the Find Tool results list without opening the
records:

1.

Select Cataloging > Bibliographic Records from the Polaris Shortcut Bar, or press
F12.

The Find Tool appears.

© 2023 Innovative (Part of Clarivate)
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Tip:
You can preview bibliographic records from remote databases, but the
circulation statistics do not appear.

2. Search for the bibliographic record or records. See Find cataloging records in your
library’s database.

The records that match the search criteria appear in the results list.

3. Select the bibliographic record that you want to preview, right-click, and select Pre-
view.
Tip:
To see more of any part of the window, drag the panel edges.

The Preview window opens. For more information, see Viewing Circulation
Statistics and Linked Item Records.

4. To preview other bibliographic records in the list, leave the Preview window open,
click in the Find Tool results list, and press the down arrow key.

Finding Polaris Records

You use the Polaris Find Tool to search for existing records in your local database and
to perform actions with these records without having to open them. You can use the
Find Tool to do a basic search, or you can use various options to focus your search
more precisely. If your library has established connections to other remote databases,
you can also use the Polaris Find Tool to search these databases.

Note:

For information about searching for Polaris Administration records, such
as libraries, branches, staff members or workstations, see the Polaris
Administration Guide, Find an administration record. For information
about searching for permissions, see the Polaris Administration Guide,
Finding Permissions.

See also:

e Polaris Find Tool Overview

» Doing a Basic Search

e Doing a Browse Search

e Doing a Keyword Search
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» Doing a Phrase Search

» Doing Power Searches
» Setting Up SQL Searches
e Scoping Searches for Bibs and ltems

e Searching Branches

» Searching Collections

o Searching Remote Databases

Polaris Find Tool Overview

With over 600 access points as well as relevancy ranking, sorting, limiting, proximity
searching, CCL queries, scoping, SQL searches, and automatic suggestions, the Polaris
Find Tool provides search options for all types of tasks. You can save user defaults for
the types of searches you do most often.

The “count only” option gives you a simple count, such as the number of DVDs in a
certain collection, without returning the search result list. You can add records to a
record set from a “count only” search without returning the records in a the results list,
or you can select the records from the results list and put them in a record set.

Your library can set up Z39.50 targets for external databases that you can search
directly from the Find Tool - allowing you to save new records to the local database in
one step.

If you have the required permissions, you can create and save a SQL search in the
Polaris Find Tool. SQL searches are used for data retrieval only; data cannot be
manipulated through the Find Tool. Once a SQL query is saved, other staff members can
use the saved search even if they do not have permission to create and save one.

In addition to the many methods and access points available for searching in the Find
Tool, you can perform tasks on single or multiple records listed in search results,
provided you have the required permissions. If you select a single record, you can select
Links to access the linked records. From the bibliographic search results, you can select
Preview to see the titles’ circulation statistics. Other options include checking in
multiple serial issues and bulk-changing multiple item records.

You can also use the Polaris Find Tool to create quick reports from the search results
list. For example, if the library needs to see a list of items in a certain collection that
have not circulated in the last three years, you can create a report in the Find Tool by
printing the results list.

See also:
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Find Tool Tab Display
Set Find Tool results limits

Get a count of records without displaying them

Customize the Find Tool by user

Find Tool Tab Display

When you search for bibliographic or item records, all the Find Tool tabs are displayed:
General, Settings, Scoping, Branches, Collections, and Databases.

All tabs are also displayed when you search for an object that has bibliographic or item
records in the Object list. For example, when you search for Community Records,
Bibliographic Records or Item Records can be selected in the Object list.

However, if the tab cannot be used in the context of the search, a message appears on
the tab. For example, if you are searching for a bibliographic record using a Browse
search type, and you select the Scoping tab, the message Scoping is not applicable in
this context appears.

For most other records (objects), such as Acquisitions, Serials, and Patron records, only
the General and Settings tabs are displayed.

Set Find Tool Results Limits

The greater the number of records retrieved and displayed in the results list, the slower
the retrieval time. To ensure optimal performance, a default retrieval limit is set in
Polaris Administration, but you can change the limit for a specific search. You can also
increase the amount of time the system will search before timing out. For information
on Find Tool error messages and how you can resolve them, see Resolving Find Tool
Search Issues.

Note:
For more information on the Find Tool profiles in Polaris Administration,
see the Polaris Administration Guide, Setting Find Tool Profiles.

To specify how you want retrieval results to be handled:
1. Open the Find Tool.
2. Create your search query, but do not click Search yet.
3. Select the Settings tab.
Tip:
These settings remain in effect until you click New search or close the
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Find Tool. Changing the settings here does not affect the default settings
in Polaris Administration. You can restore the default settings by clicking
Reset to Default.

The Settings tab appears.

4. If you want to create a record set from the results, check Send Results to a New
Record Set. Search the Polaris help for "Create a record set from all the Find Tool
results.”

5. If you want to change the default settings, do the following:

Tip:

If the number of records returned in a search is equal to the retrieval limit,
increase the retrieval limit to make sure all records that meet your search
criteria are retrieved.

» Type a different number to change the number of records that are retrieved in the
Retrieval Limit box. The default limit is set in Polaris Administration with the
profile Find Tool: Default number of records to return in a result set. See the
Polaris Administration Guide, Set Find Tool defaults. To set the retrieval limit back
to the default, click Reset to Default.

» Type a different number in the Search Timeout (sec) to increase or decrease the
amount of time (in seconds) that the system will search before timing out. The
default is 30 seconds.

Tip:
If you want Polaris to sort records, you must select a Sort by option on the
Find Tool’s General page.

e Check or clear the Use Initial Articles Table checkbox. If this box is checked, the
initial article in a title is ignored if that article is defined in the Initial Articles table
(see the Polaris Administration Guide, Defining Leading Articles).

Get a Count of Records Without Displaying Them

You can use the Count only option with any type of search, including an SQL search. To
search for specific types of records and get a count of the records without displaying
them in a list:

1. Enter your search criteria on the Find Tool- General tab.
2. Select Count only.
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Tip:
If you want to add the records to a record set, go to the Settings tab and
enter the information for the record set before clicking Search.

3. Click Search. A count of the records appears in the status line of the Find Tool.

@ Item Records - Circulation status Find Tool - X
File Edit Tools Options Help
General Settings Scoping Branches Collections Databases
- Search Mode Search
Object: Ttem Records ~ | Limit by: | (None)
(@ Normal
Search by: | Circulation status ~ | Value: () Power
Type: Exact match (implicitly truncated) ~ OsaL e
Sortby:  (None) v [+] Count only Clear
For: | Lost v Help
Daone Stay on Select <_62796 record(s) found=User de

Note:

When you select Count only, the Retrieval Limit on the
Settings tab is ignored so that the count includes all records
that meet the selected criteria, but the Search timeout setting
is still in effect.

Customize the Find Tool

You can customize the Find Tool to save default general search criteria and, for
bibliographic record searches, to save default remote search databases.

Your custom default search settings are associated with your user account and are
used each time you sign in with your user ID. You can change your default search
settings at any time.

Save Default General Search Criteria

You can set the Find Tool to default to the same selections in the Search by, Type, Sort
by, and Limit by boxes each time you search for the same type of record.

Values that can be selected from drop-down lists are also saved, but free-text values are
not. For example, if you select Genre in the Search by or Limit by box, enter a free-text
value, and select Save as User Default > Genre will be retained, but not the free-text
value.

To customize the Find Tool:
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Open the Find Tool.
Select the record type you want to find.
Select an option from the list in the Search by box.

-

If you want the search results sorted the same way every time you search for that
type of record, select an option in the Sort by box.

5. If you want the search results limited in the same way every time you search for
that type of record, select an option in the Limit by box, and select a value in the
Limit by values box.

Note:

Limit by values selected from a drop-down list are saved in the user
default, but free-text values are not saved. For example, if the Limit

by selection is Subject and you enter history in the Values box, the value
is not saved.

6. Select Options > Save as User Default from the Find Tool menu bar.

Tip:

If you save a Power search as the user default, the Find Tool will open to
the Power Search tab the next time you search for the same type of
record, but the search criteria are not saved.

The Find Tool is customized to search for the record by the option you selected in
the Search by box. To set the Search by option back to the default for the record
type, select Revert to System Default.

Note:

If you set user defaults for the bibliographic or item record Find Tool,
these defaults are in effect in the Find Tool shortcuts (F12 for bibs and
Ctrl+Alt+F9 for items).

Save Default Remote Search Databases

Note:
Default search databases can only be saved for bibliographic record
searches.

To save default search databases:
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Open the Find Tool for bibliographic records and navigate to the Databases tab.
Select the remote databases you would like to search.

Select Options > Save as User Default.

Polaris saves your preferred remote search databases. When you open the Find

Tool for bibliographic records in the future, your preferred search databases are
already selected.

To clear saved default search databases:

1.
2.

Open the Find Tool for bibliographic records, and navigate to the Databases tab.
Select Options > Revert to System Default.

Resolving Find Tool Search Issues

If you enter the search criteria and the results do not appear or are fewer than expected,
try the following:

On the Settings tab, increase the number in the Retrieval Limit box. This resets the
retrieval limit for the current search only. If you select New Search, the retrieval
limit reverts to the default set in Polaris Administration.

Select the Count only checkbox with the same search criteria selected. This will
give you the actual count of all the records that meet your search criteria, regard-
less of the number in the Retrieval Limit box.

On the Settings tab, increase the number in the Search Timeout (sec) box.

If you enter the search criteria, and you encounter a CCL Syntax error that states,
Invalid Search. Please verify the query and then resubmit the search., you can
enter the primary search criteria on the General tab and then use the Scoping tab
to refine the search. For example, the Invalid Search message appears if you
select Type of material in the Limit by box and select all values except for Book. In
this case, the Limit by option is being used to exclude the Book type of material,
but include all other values.

Instead of using the Limit by option to exclude a specific type of material, you
could enter the primary search criteria, on the General tab, then go to the Scoping
tab to exclude the book format. The search results display the bibliographic
records with that title in every format except book.
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Doing a Basic Search

The Find Tool appears when you select a subsystem and record type from the Polaris
Shortcut Bar, or when you click Find on workforms and dialog boxes. You can also press
F12 from anywhere in the Polaris staff client application to open the Find Tool and
search for bibliographic records, or Ctrl+Alt+F9 to search for item records.

When the Find Tool opens, select the type of record to search for (object), the access
point to search by, and the type of search. Then type the word or phrase to use for the
search. In addition, you can use various options on the Find Tool to narrow your search
results, specify how to sort the results, or get a simple count of the number of records.

Depending on the type of record, you can display the records in the Find Tool results list
and add them to a record set, or select Count only and add them all to a record set
without having to display them in a list. If you want to add specific records to a record
set, you can display them in the results list, right-click the selected records, and select
Add to Record Set from the context menu.

If you usually search for records using the same criteria, you can save the search
options as your user default. For example, if you usually search for bibliographic records
by title and limit the search by material type, you can set this up as your default. You can
also specify sorting options as part of your user default. Each time you search for
bibliographic records, the options are set automatically. For more information, see
Customize the Find Tool by user.

You can have multiple Find Tools open at once. The title bar of each Find Tool displays
the object and access point selected for that search. For example, if you are searching
for an item record by barcode, the title bar displays Item Records - Barcode Find Tool.

Important:

Your Polaris administrator may set the Find Tool so that search results
are filtered according to your staff member permissions and those of the
workstation you are using. In Polaris Administration, if the Staff Client
profile Find Tool: Filter search results by permission is set to Yes, you
will see only the records for which you have Access permission. If it is set
to No, you can see records in the search results even if you do not have
permission to access (open) them.

See also:

o Set Up a Search

e Search for a record
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Set Up a Search

A search query is a structured request for database information. The simplest query
uses default settings, and you simply type a word or phrase to describe the records.
This word or phrase might be, for example, a full or partial title, the last name of an
author, a patron’s name, or a purchase order number.

A standard search query on the Find Tool requires the following four criteria:

» Record (Object)

» Access point (Search by)
» Type of search (Type)

« Search string (For)

You can also narrow your search by selecting an option in the Limit by box, and then a
value in the Value box. To sort the results before they are returned, select an option in
the Sort by box. The options in the Limit by and Sort by boxes depend on the type of
record you selected in the Object box.

Record (Object)

The record types that you can select in the Object box depend on the menu option,
workform, or field where you accessed the Find Tool. For example, in a Purchase Order
workform, if you click Find in the Supplier field, the Find Tool opens with Supplier in the
Object box. When you open the Find Tool from the Funds field, Fund is selected in the
Object box.

Access Point (Search by)

You select the access point in the Search by box. The list of access points depends on
the record type you selected in the Object box. For example, access points for
bibliographic records include Title, Author, and Subject (among others). You can set
your own default Search by access point for each record type. Then, whenever you log
on with your user ID and search for a record using the Find Tool, the Search by option is
automatically set for the record type. See Customize the Find Tool by user. You can set
the option back to the system default at any time.

Search Type

The available search types depend on your selections in the Object box and the
Search by box.
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Tip:
When you do a title search, Polaris checks fields in the bibliographic
record indexed for title searching, such as the 245, 246, 440, and 740 tags.

« Exact match (implicitly truncated) - Displays all the records beginning with the let-
ters or numbers in the For box. No asterisk is needed after the term in this type of
search. However, you may want to enter an asterisk before the search term. See
Using Wildcard Characters in Searches.

Example:
Type energy in the For box for a bibliographic title search. The results list
includes all titles that begin with energy.

» Exact match (explicitly truncated) - Displays only the records that exactly match
the letters or numbers in the For box. If you use an asterisk, the Results list dis-
plays the same records as those of an implicitly truncated search.

Example:

Type energy in the For box for a bibliographic title search. The results list
includes only items titled energy.

If you type energy*, the results are the same as for an implicit search of
energy.

» Browse - Display the specified index headings, beginning with entries that start
with text similar to the text in the For box. For example, a browse title search for
trains displays the portion of the title index containing the first title that starts with
trains. Browse searching is Unicode-compliant, so you can enter diacritics or spe-
cial characters and the headings display that begin with the characters. See Doing
a Browse Search.

» Keyword search - Finds records that include the exact search term or terms you
input, in any order. There is an implied and between multiple words. For example, a
keyword title search for trains displays a list of items that have the word
trains anywhere in the title. See Doing a Keyword Search.

» Phrase search - A special kind of keyword search for multiple words in the exact
order in which you entered them. See Doing a Phrase Search.

Sort By
Tip:

The Sort by option is not available for browse searching.
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If you want search results to display in a specific order, you can select an option in the
Sort by box. The sort option can be part of your user default settings when you are
searching for a specific type of record. For information on setting a user default search,
see Customize the Find Tool by user.

The available options in the Sort by box depend on the record. For example, if you are
searching for a bibliographic record, you can select from the following sort options:

e Author

 Author, the Publication Date

e Author, then Title

» Call Number

e Call Number, then Author

 Call Number, then Publication Date

e Call Number, then Title

e Control Number

» Most Popular

» Publication Date

e Publication Date, then Author

e Publication Date, then Relevance

e Publication Date, then Title

» Relevance

o Title

 Title, then Author

« Title, then Author, then Type of Material

« Title, then Publication Date

« Title, then Type of Material

» Type of Material

Search String (For)

You specify the search string in the For box by typing one or more characters. Polaris
ignores letter case, multiple spaces, and all punctuation (except quotation marks)
entered in the For box. The search does consider special characters and diacritics.
Consider the following when entering text in the For box:
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Initial articles

If the Use Initial Articles Table checkbox is checked on the Settings tab, the initial
article in a title is ignored or “stripped out” if that article is defined in the Initial Articles
table in Polaris Administration (see the Polaris Administration PDF Guide, Defining
Leading Articles.).

Example:
Searching for The Great Gatsby yields the same results as searching for
Great Gatsby.

The checkbox is used when the search type is Exact match (either implicitly or explicitly
truncated), and you are searching for the following records:

« Authority Records (Heading, Tracing/Reference)

« Bibliographic Records (Title and Series)

» Check In Records (Title)

« Claims (Title) (both for Acquisitions and Serial versions)

« Course Reserve Records (Title)

» Hold Requests (Title)

 ILL Requests (Title)

« Invoice Line Items (Title)

« Issue Records (Title)

« Item Records (Title and Series)

 Part Records (Title)

» Purchase Order Line Items (Title)

» Reserve Item Records (Title)

» Route Lists (Title)

« Selection List Line Items (Title)

« Serial Holdings Records (Title)

 Subscription Records (Title)

Reusing a search string

All the search strings you type in the For box are retained during a Polaris session. To
use a search string for another search, select the string in the For box.

Using an implicitly truncated search - A title search for “bulletin” could be done using the
following string: bulle.
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Note:

If you can use an ampersand (&) in a search string for phrase and
keyword searching, it is equivalent to the word and. The ampersand and
the word and are not interchangeable for exact match or browse
searching.

Using Wildcard Characters in Searches

Wildcard characters are the special characters asterisk * or question mark ?, which you
can use in a search to represent the rest of the word in keyword and exact match -
implicitly truncated searches. A wildcard character is not necessary after the search
term in an exact match - implicitly truncated search because the truncation is implied.
However, you may want to enter an asterisk before your search term if you are not sure
if something comes before the search term.

Examples:

Keyword searching - The entry King* for a keyword author search yields
results such as King, Kingsley, and Kingford. The entry *King* for a
keyword author search yields results such as Talking Heads, Dykinga, and
Polkinghorne.

Exact match (implicitly truncated) -The entry material for a selection list
line item notes search gets no search results. However *material finds the
selection list line item that has the note: This is printed music, but the
material type is set to 28 Youth. The search finds the results because it
looks for material anywhere in the note.

Limit By

Tip:
The Limit by option is not available in Browse searches.

You can limit your search to narrow the results. For example, you can search for a title
and limit the format to DVD. Some Limit by options have pre-set selections in the
Value box. For example, if you select Language, a list of languages appears in the
Value box. But, if you select Author, you type the author's name in the Value box. You
must be precise when you enter free text in the Value box because there is no implicit
truncation. When you enter only a part of the value you want to limit by, you must also
enter an asterisk.
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Example:
If you are searching for item records by title, and you limit by Current
borrower, type the patron’s name in the Value box in these formats:

last name*
last name, first name*
last name, first name middle name

You must include the comma and the wildcard character as shown. The
last name alone will not work in the Value box.

The specific languages listed in the Value box are set in the MARC Language Scoping
Display policy table. This list is used if the Staff Client profile Find tool: Use language
scoping display is set to Yes in Polaris Administration. See the Polaris Administration
PDF Guide, Setting Language Display.

Search for a Record
To do a simple search for records:
Note:

If you encounter any issues with your search, see Resolving Find Tool
Search Issues.

1. Open the Find Tool using one of these methods:
» Select a menu option from the Polaris Shortcut Bar.
 Click Find on a workform.
« If you are searching for a bibliographic record, press F12.
The General tabbed page of the Find Tool appears.

2. If the object selected is not what you wanted to search for, select the record type
to search for in the Object box.

Tip:
To quickly locate an item in a list box, type the first letter. For example, to
search by genre, open the Search by list and press G.

3. Select the access point to search by in the Search by box.
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Note:

If you select a date option in the Search by box (for example, you are
searching for serial issues and select Expected arrival date), the Find Tool
displays date range boxes where you select the beginning and ending
dates from a calendar.

Select the type of search in the Type box.

Tip:

If you have selected an access point and a search type, but then decide to
change the access point, the search type is retained. For example, if the
search type is Keyword and the access point is Author, you can switch the
access point to Title and the search type will be retained because both
access points can be used with keyword searching.

If you want to sort the results before they appear in the list, select an option in the
Sort by box.

Type a search string in the For box.

If you have entered a search string but decide to search for a different object, you
can switch the object while retaining the same search string.

Example:

You search for bibliographic records by author and then you want to
search for item records with the same author. You can select Item
Records in the Object box and the author’'s name remains in the For box.

If you want to narrow your search, select an option in the Limit by box, and select
or type a value in the Value box.

Note:

The Value box lists options for some Limit by settings, while other
settings require a text entry in the Value box. For example, if you select
Language in the Limit by box, the Value box contains a list of languages.
If you select Author in the Limit by box, you type the author's name in the
Value box. If you enter a portion of a Limit by value, you must enter an
asterisk. For example, select Author in the Limit by box and enter Kin* in
the Value box to display works by authors named King, Kings, Kingsley,
and others. See Limit By.
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Tip:

The results list automatically clears when you start another search. You
can also click New Search to close the results list, return the Find Tool to
its default settings, and clear the For box.

Click Search or press ENTER. If you want to cancel the search, click Stop or start a
new search with a different query. The results list appears in the Find Tool win-
dow.

Important:

If you see the message Could not connect to the Z3950 search engine,
try increasing the search timeout limit. Select the Settings tab, and type a
larger number in the Search Timeout (sec.) box. For example, if the
timeout is set to 30 seconds, increase it to 60 seconds. The search
process continues for 60 seconds, if necessary.

Tip:

Check the status line to see if all results are displayed. If not, you can
press CTRL+SHIFT+A to return all results.

To sort the list after the results appear, you can click on the column
headers.

To work with a record in the results list, do one of the following actions:

Double-click a line item to open the record in a workform (search Polaris help for
"Using Polaris Workforms").

Right-click a line item, and select an option from the context menu. The specific
context menu options depend on the selected record type. Search the Polaris help
for "Use the context menu in the Find Tool results list."

Related Information

Customize the Find Tool by user

Doing a Browse Search

Doing a Keyword Search

Doing a Phrase Search

Doing Power Searches
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o Setting Up SQL Searches

e Scoping Searches for Bibs and ltems

Doing a Browse Search

You can select Browse as a search type only when you are searching for bibliographic
records by Author, Call number, Series, Subject, or Title. When you browse by author,
series, or subject, the index opens to the authorized heading that begins with what you
entered in the For box. You select the heading to display the titles associated with it.
When you browse by title, the results list displays the portion of the alphabetical title
index that begins with the text you typed. When you browse by call number, the portion
of the catalog that begins with the call number is displayed. Browse searching includes
Unicode support for searching by author, subject, series, and title. You can enter
diacritics and other characters when browse searching.

Note:
The Limit by, Count only, Sort by and Add to Record Set options do not
apply to browse searches.

See also:

» Browse by Author, Series, or Subject

o Browse by Call Number or Title

Browse by Author, Series, or Subject

To browse search for bibliographic records by author, series, or subject authorized
headings:

Note:
You cannot browse by author, series, or subject when using the Find Tool
from within a workform.

1. Onthe Find Tool, General tabbed page, select Bibliographic Records in the Object
box.

2. Select Author, Series, or Subject in the Search by box.
3. Select Browse in the Type box.

Tip:
Type the name of the author using the format: last name first
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name. For example, type William Shakespeare as
Shakespeare William.

4. Type the name of the author, the series name, or the subject word in the For box.

Note:
You do not need to type the entire index heading.

5. Click Search to begin searching. Author, subject, or series headings appear in the
results list. The numbers in the Count column specify how many records are asso-
ciated with that heading.

Note:
You can select a See or See Also cross reference.
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Fle Edit Cptions  Help
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Latin Amsrica 12
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Latin Amesrica--Armed Forces 1
Latin Amesrica--Biagraphy ]
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Latin: Amsenica--CidliZation 16
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Latin Amernica--Descripbion and rawve 1z
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Do Stay on Select Lser dedault

6. Double-click a heading. The Heading dialog box displays the titles associated with
the heading.
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If you want to open the record, double-click it in the list. The Bibliographic Record
workform opens for the title you selected.

Browse by Call Number or Title

To browse search for bibliographic records by bib call number or title:

1.

On the Find Tool, General tabbed page, select Bibliographic Records in the Object
box.

Select Call number or Title in the Search by box.
Select Browse in the Type box.

Type the call number or title in the For box. You do not need to type the entire title
or call number.

Click Search. The results list displays the portion of the title or call number index
that begins with your search text.
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6. Right-click a title line item, and select Open from the context menu to display the
record in the Bibliographic Record workform.

Doing a Keyword Search

When you select a record type in the Object box and an access point in the Search by
box, Keyword search appears in the Type list if available for this combination of record
type and access point.

For some types of records, keyword searching is available because the selected Search
by access point actually searches in linked records. For example, when you search by
Title for a line item in a selection list, purchase order, or invoice, Keyword

search appears in the Type box because the system searches for the line item by the
title in the linked bibliographic record.

Keyword searching is available for the following types of records (depending on the
selection in the Search by box):
e Acquisitions
o Claims
° Invoice Line Items

© 2023 Innovative (Part of Clarivate)
Page 46



o

o

Purchase Order Line Items
Selection List Line Items

» Cataloging

o

o

o

o

o

o

o

Authority
Bibliographic
Community
Course Reserves
ltems
Promotions
Reserve Items

e Patron Services/Circulation

o

o

o

o

Course Reserves
Hold Requests
ILL

Patron Records

e Serials

[e]
o
[e]
[e]

o

See also:

e Automatic Suggestions in Keyword or Phrase Searching

Claims
Issues

Parts

Route Lists
Subscriptions

e Search by keyword

Automatic Suggestions in Keyword or Phrase Searching

Cataloging Guide

If your library system has the Cataloging parameter Auto-suggest feature enabled set
to Yes, a list of suggestions appears as you type if you are doing a keyword or phrase
search for a record by an access point that is keyword-indexed. Automatic suggestions
do not appear if you are searching a remote database. See the Cataloging

Administration PDF Guide, Managing Auto-Search Suggestions..

Note:
You can turn automatic suggestions off by selecting Hide Suggestions at
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the bottom of the list of suggestions. To turn them back on, cIick in
the For box.

Automatic suggestions for patron records

When you do a keyword or phrase search for a patron record using any of the following
access points, a list of suggestions appears automatically as you type:

Phone Number

Address (StreetOne, StreetTwo)
City, State PostalCode (ZipPlusFour)
Email Address

Name (First, Middle Last)

Name (Last, First Middle)

Automatic suggestions for bibliographic or item records

When you do a keyword or phrase search for a bibliographic record or item record using
any of the following access points, a list of suggestions appears automatically as you

type:

Author
General notes
Genre
Publisher
Subject

Title

Automatic suggestions for authority records

When you do a keyword or phrase search for an authority record using any of the
following access points, a list of suggestions appears automatically as you type:

Heading

All keyword fields
Conference name
Corporate name
Genre/Form subject
Geographic name
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LC children’s subject
LC subject

Name

Personal name
Subdivision heading
Topic term
Tracing/Reference

Search by Keyword

To find records using keyword searching:

1.

On the Find Tool, General tabbed page, select the record type that uses keyword
searching in the Object box.

. Select an access point for which you can use keyword searching in the Search by

box:

. Select Keyword search in the Type box.

Tip:

You can type part of a word and use a wildcard character. For example, if
you type King* for a keyword author search, then the results list includes
works by authors named King, Kings, Kingsley, and others. You can also
use wildcards in the beginning of a word to indicate that something may
come before it. See Using Wildcard Characters in Searches.

Type one or more keywords, in any order, in the For box.

Note:
Automatic suggestions may appear as you type. See Automatic
Suggestions in Keyword or Phrase Searching.

If automatic suggestions appear, and one is the search term you want to use,
select it. The results appear as soon as you select an automatic suggestion.

If no automatic suggestions appear, or they are not useful, click Search to begin
searching. Titles appear in the results list.
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Doing a Phrase Search

A phrase search looks for multiple words in the exact order you type them. You can do a
phrase search for bibliographic and item records. When you select Phrase in the

Type box and type a phrase in the For box, the search looks in all indexed fields for that
phrase in the same word order. You can also narrow the search to look for the phrase in
specific fields. Phrase searching is not available for all access points. For example, if
you are searching for a bibliographic record and select Call number in the Search

by box, phrase searching is not available in the Type box.

To do a phrase search:

1. Onthe Find Tool, General tabbed page, select Bibliographic Records or Item

Records in the Object box.

Tip:

You can use wildcards in the beginning, middle, or end of phrase search
strings to indicate that other words come before, in the middle, or at the

end of the search string.

2. Select one of the following access points in the Search by box:

» All Keyword Indexed Fields
e Author

» General notes

e Genre
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e Series
o Subject
o Title

3. Select Phrase in the Type box.
4. Type the phrase in the For box.

Note:
A list of suggestions may appear as you type. See Automatic Suggestions
in Keyword or Phrase Searching.

5. If automatic suggestions appear, and one of the suggestions is the phrase you
want to search by, select it. The results appear as soon as you select an automatic
suggestion.

6. If no automatic suggestions appear, or they are not useful, continue typing the
entire phrase, and click Search. Titles appear in the results list.

Doing Power Searches

With power searching, you can construct complex, precise searches by writing Common
Command Language (CCL) queries. Power searching is a good way to list records that
share a combination of very specific characteristics. To construct a power search, you
can begin with a basic search expression and then add more search expressions to it, or
you can write the entire query.

Note:

You can do complex searches for cataloging records and have Polaris
format the information you provide into CCL for you. See Scoping
Searches for Bibs and Items.

See also:
o Setting Up CCL Queries
» Mnemonic Codes for Access Points
e CCL Operators
» Wildcard Characters
e Quotation Marks in Power Searching

o Power-Searching for Multiple ISBNs

» Write a power search query
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Setting Up CCL Queries

CCL queries in the Find Tool consist of one or more search expressions. Each search
expression is a search string and a series of symbols and operators specifying the
desired search results.

Tip:

You can change the time out for the search from the default of 30
seconds to another length of time by typing TIMEOUT=(number). For
example, if you want to search for United States and increase the time out

to 60 seconds, type:
KW=United States and TIMEOUT=60

A search expression includes the following components:

» Access point - A search field identifier, such as author or title. Also known as a
qualifier.

» Operator - The logical link between an access point and a search string, or
between search expressions.

» Search string - A string of characters identifying the item for which you are
searching. Also known as an item description, search term, or value.

Example:
The following query, composed of two search expressions linked by AND,
finds the works of author Asimov published in or after 1970:

AU=asimov AND PD >= 1970
where

AU and PD are access points (Author and Publication Date)
=, AND, >= are operators
asimov and 1970 are search strings
You can group search expressions with parentheses to direct the order of operations.

Mnemonic Codes for Access Points

When you are creating queries, you must use the mnemonic code, and not the full term,
for the following access points:
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g:)z::c.:hes and collections are available only with normal searches.
» Find Tool Search by options
« Language (LA)
» Target audience (TA)

« Collection (COL) - Click the Collections tab on the Find Tool to see the
abbreviations for your system.

 Assigned Branch (AB) - Click the Branches tab on the Find Tool to see the
abbreviations for your system.

CCL Operators
The following are CCL operators:
» Boolean (logical) operators - AND, OR, NOT logically connect items

« Proximity (nearness) operators - Specify the location of and distance between
items

» Relational operators - Specify comparative relationships between items, such as
greater than, less than, or equal to

Boolean Operators

The Boolean operators AND, OR, and NOT combine search expressions in logical
sequences:

» AND - A record must match both the search expression before and the expression
after the operator to be included in the search results.

Example:
AU=isaac asimov AND Tl=planets

Finds only the items written by Isaac Asimov that have the word planets in
the title.

» OR - Arecord must match either the search expression before or the expression
after the operator, or both, to be included in the search results.

Example:
AU=isaac asimov OR Tl=planets

© 2023 Innovative (Part of Clarivate)
Page 53



Cataloging Guide

Finds all items written by Isaac Asimov and all items with the word
planets in the title by any author.

» NOT - Arecord must match the search expression before the operator, but not the
expression after the operator to be included in the search results. The expression
after the operator must be enclosed in parentheses.

Example:
AU=isaac asimov NOT (TlI=planets)

Finds only those items written by Isaac Asimov that do not have the word
planets in the title.

You may build a more complex query using the Boolean operators. When using multiple
operators in the same query, use parentheses to group the search expressions so that
they are done in the correct order, from left to right.

Proximity Operators

The proximity operators N, Nn, W, and Wn specify the relative position of search terms in
the search results. Proximity operators are used with a number representing the
distance between the two terms (the proximity distance). Adjacent terms have a
proximity distance equal to 1, and the default proximity relation is LE (less than or equal
to).

If the proximity operator begins with N, it indicates the search terms may be separated
by the specified number of words in any order. For example, a power search for
KW="United States" N2:EQ KW="Union" searches for records where the phrase United
States appears exactly two words before or after the keyword Union.

If the proximity operator begins with W, it indicates the search terms must be within the
specified number of words in the specified order. For example, a power search for
KW="Harry Potter" W10:LT KW="J.K. Rowling" searches for records where the phrase
Harry Potter appears less than 10 words before the phrase J.K. Rowling.

* Nor % -Indicates the search terms should be next to each other in any order.

Examples:
AU="james" N AU="joyce"
AU="james" % AU="joyce"
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Finds any items with authors that have the names James and Joyce next
to each other, such as James Joyce or Joyce James.

* Nn - Indicates the search terms may be separated by the specified number of
words (n) in any order, where n is a number between 1 and 9.

Example:
AU="james" N4 AU="joyce"

Finds any items with authors that have the names James within four
words of the name Joyce, such as James C. Joyce or Joyce and Roberta
James.

« Wor!-The search terms must be next to each other in the specified order.

Examples:
AU="james" W AU="joyce"
AU="james" ! AU="joyce"

Finds any items written by James Joyce, but ignores items written by

Joyce James.

» Wn - The search terms must be within the specified number of words (n) in the
specified order, where n is a number between one and nine.

Examples:
AU="james" W4 AU="joyce"
AU="james" 14 AU="joyce"

Finds any items written by James C. Joyce and James Robert Collins
Joyce, but ignores items written by Joyce C. James.
Relative Operators

The relative operators include the following mnemonic codes for comparing items:

Mnemonic

Operation Code/Relative
Operator

Equal to specified item EQ or =
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Mnemonic
Operation Code/Relative
Operator
Not equal to specified item NE or <>
Less than specified item LT or<
Less than or equal to specified item LE or <=
Greater than specified item GT or >
Greater than or equal to specified item GE or >=
Equal to specified item EQor=
Examples:
- The following example finds items published in or after 1987:
PD GE 1987

- The following example finds items published before 1932 that have the
words solar system in any indexed field:
KW=solar system AND PD < 1932

Wildcard Characters

You can use the following special characters to search for character pattern matches to
the item description:

Tip:

Enter as much of the base search term as you can because the shorter
the base, the more imprecise the search. For example, entering bee* can
yield search results of bees, beer, or Beecher.

» Question mark (?) - Indicates 0 or more characters. For example, type child? to find
child, children, child's, and so forth.

o Asterisk (*) - Indicates 0 or more characters. For example, type west* to find west,
western, West's, and so forth.

« Number sign (#) - Indicates 0 or 1 character. For example, type wash# to find
wash, washi, washy, and so forth.
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Quotation Marks in Power Searching

Tip:

You can enclose any search string in quotation marks. If you are not sure
whether to enclose the search string in quotation marks, you can always
safely use them.

Strings containing the following words and characters must be enclosed in quotation
marks if they are used as part of an item description in a CCL search:

Tip:

The number sign (#) is treated as a single-character wildcard and not as
the character itself. Therefore, a power search for TI="#*" does not limit
the results to records with # in the title. Instead, use an embedded SQL
search with 9999 as the Bib-1 Use attribute for ADHOC.

To search for bibliographic records with # in the title, enter the following
in the Power Search Criteria box:

[9999]="SELECT RecordID FROM Z3950_AP_BR_TI_S WHERE Term LIKE
I#%lll

To search for item records with # in the title, enter the following in the
Power Search Criteria box:

[9999]="SELECT RecordID FROM Z3950_AP_IR_TI_S WHERE Term LIKE

g0
N ?
N[1-9] #
% =
W <>
W[1-9] eq
| g‘t
and It
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or ge
not le
* -
&

Examples:

- To find the title Bud, Not Buddy, you type the following command:
Tl = “bud not buddy”

The string must be enclosed in quotation marks because in a CCL
command, not is ordinarily a Boolean operator.

- To find the telephone number 453-7890, you type the following
command:

PHONE = “453-7890"

The string must be enclosed in quotation marks because in a CCL
command, the hyphen (-) ordinarily separates two values, indicating a
range of values between the two.

Power-Searching for Multiple ISBNs

Tip:

If you are pasting the ISBNs from another source (such as a Word
document) that uses the curved “smart quote” characters, change the
quotation marks to straight quotes in the search command.

The internal limit to the number of search terms you can enter with no parentheses is
10. If you search for multiple ISBNs, you can avoid this limit by placing each ISBN in
quotation marks. The example shows the syntax you can use:

Example:
Each number represents an ISBN.
ISBN={II1II, ll2ll, ll3ll, ll4ll}

Write a Power Search Query

To do a complex, precise search by writing a query in Common Command Language

Note:
Search expressions are not case-sensitive. That is, you can use uppercase
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letters, lowercase letters, or a combination of both. They do not affect the
results.

Tip:
To delete all the information in the Power Search Criteria box, click Clear.
To start a new search with a basic search expression, click New Search.

To create a basic query first, select a record type in the Object box and enter the

search criteria in the Search by, Type, and For boxes on the Find Tool - General

tabbed page. See Doing a Basic Search.

. Click Power. The General page displays a Power Search Criteria box. If you cre-

ated a query in the previous step, the query appears in the Power Search Criteria
box.

Important:

You must write your power search queries precisely. This means you may
need to edit search expressions that are carried over to the Power Search
Criteria box. For example, to find the works of all authors with names
beginning with Shake, type AU=shake* in the Power Search Criteria box.
If you type AU=shake, only the works of authors named Shake are found.

Input additional criteria or edit existing criteria in the Power Search Criteria box,
using CCL syntax.

4. Click Search to begin searching. The results list appears.

Setting Up SQL Searches

You can do a search for records using Structured Query Language (SQL). SQL is a
computer language used to create, modify, retrieve and manipulate data from relational
database management systems, such as Polaris. In the Polaris Find Tool, SQL is used
for data retrieval only. You cannot manipulate data in the Polaris database through SQL
searching.

To use all the options for SQL searching in the Find Tool, you must have permissions set
in Polaris Administration. Separate permissions are required for accessing the SQL
searching mode and saving search strings to the database. See the Polaris
Administration PDF Guide, Special Permissions for SQL Searches in the Find Tool.

Tip:
You can save text, even if it is not a legitimate SQL search, as a rough SQL
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template that users can use as a basis for searching. They can edit the
search in the Search Criteria box without saving the changes to the
template.

In the Polaris Find Tool, the SQL query must use the following structure:
SELECT Column From Table Where Limit criteria. The column name must match the
column name in the database.

Examples:

To find item records without an assigned collection, type: SELECT
ItemRecordID FROM CircltemRecords WHERE AssignedCollectionID IS
NULL

To find item records with no statistical code, type:SELECT ItemRecordID
FROM CircltemRecords WHERE StatisticalCodelD IS NULL

To find item records with the circulation status of Lost, type:SELECT
ItemRecordID FROM CircltemRecords WHERE ItemStatusID = 7

To find item records that have a temporary shelf location, type:SELECT
ItemRecordID FROM ItemRecordDetails WHERE
TemporaryShelfLocation IS not NULL

To find patron records where the registration expiration date is before or
equal to October 31, 2009, type:SELECT PatronID from
PatronRegistration WHERE ExpirationDate <= '10/31/09'

The SELECT command retrieves zero or more rows from one or more tables in a
database. Commonly available keywords related to SELECT include:

e« FROM - Indicates the tables from which the data is to be taken, as well as how the
tables join to each other.

» WHERE - Identifies which rows to retrieve, or applied to GROUP BY.

« GROUP BY - Combines rows with related values into elements of a smaller set of
rows.
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e HAVING - Identifies which of the “combined rows” are to be retrieved.
HAVING acts much like WHERE, but it operates on the results of the GROUP BY
function.

» ORDER BY - Identifies which columns are used to sort the resulting data.

When the search results are displayed, you can print the results for a quick report.
Search Polaris help for "Print search results from the Find Tool."

See also:
» Do a SQL search
e Search using a saved SQL search
Do a SQL Search

To search using SQL:

1. Select the type of record you want to search for in the Object box on the General
tab of the Find Tool.

Tip:
You can save the SQL search mode as the default search mode setting.
See Customize the Find Tool by user.

2. Select SQL. The SQL Search Criteria box appears.

Note:
To search using an existing SQL search, see Search using a saved SQL

search.

3. Type the SQL search criteria and click Search.

4. If you want to save the SQL search criteria, click Save, type the name of the saved
search in the Save SQL Search dialog box, and click OK. You can use this saved
search when you search for the same type of record (object).

5. Click Search. The search results appear.
Search Using a Saved SQL Search
To use a saved SQL search:

1. Select the type of record you want to search for in the Object box on the General
tab of the Find Tool.
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You can save the SQL search mode as the default search mode setting.

See Customize the Find Tool by user.

2. Select SQL. The SQL Search Criteria box appears.
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3. Select the saved search in the Open box.

Note:

The saved SQL searches listed in the Open box are those associated with

the selected record (object).

The saved SQL search appears in the Search Criteria box.

4. Click Search.

Note:

If you have permission, you can edit a saved search, and click Save
As... to rename it. See the Polaris Administration PDF Guide, Special
Permissions for SQL Searches in the Find Tool.

Scoping Searches for Bibs and Items

Scoping is a method of further focusing your search beyond the basic search
expression. Scoping, like power searching, allows you to conduct complex, precise
searches with the Common Command Language (CCL). However, power searching
requires you to know CCL and write your own queries. With scoping, you select the
access points (qualifiers), operators, and search strings (values), and Polaris formats
the information into CCL. You can use scoping with exact match, keyword, and phrase

searches for bibliographic and item records.

To do a complex, precise search by scoping:
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. Onthe Find Tool - General tabbed page, fill in the Object, Search by, Type, and
For boxes (see Doing a Basic Search).

. Click the Scoping tab to display the Scoping tabbed page. The search expression
you created on the General tabbed page appears in the Current Criteria box.

. Choose one of the following Boolean operators (see Boolean Operators):

« If the search results must match both search expressions, click And.

« If the search results can match either search expression, click Or.

« If the search results must match the first search expression, but not the
second one, click Not.

. Select an access point or modifier in the Qualifier box.

. Choose one of the following relative operators:

Tip:

You can choose [=] or [<>] for all the qualifiers.

You can choose the following relative operators for the Publication date

only: [<], [<=], [], or [>=].

Click [=] for results equal to the value.

Click [<>] for results not equal to (excluding) the value.

Click [<] for publication dates less than the value.

Click [<=] for publication dates less than or equal to the value.
Click [>] for publication dates greater than the value.

Click [>=] for publication dates greater than or equal to the value.
. Select or type a value for the query in the Value box. For additional information,
see:

Proximity Operators

Wildcard Characters

Quotation Marks in Power Searching

. Click Add to add the search expression to the Current Criteria box. If the search
expression is longer than the width of the Current Criteria box, a horizontal scroll
bar is displayed. The status bar displays SC to indicate scoping is in effect.

. To add another search expression, do these steps:
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Tip:
The original search expression, created on the General page, can be
modified on the General page.

a. Inthe Current Criteria box, select the expression which you want to pre-
cede the new expression.

b. Select a Boolean operator, qualifier, relative operator, and value.
c. Click Add to add the search expression to the Current Criteria box.

Tip:

To remove a search expression created on the Scoping page, select it in
the Current Criteria box and click Remove. To delete all the search
expressions, except for the expression that you created on the General
tabbed page, click Clear.

9. To edit a search expression created on the scoping page, do these steps:
a. Select the search expression in the Current Criteria box.
b. Change the operators, qualifier, or values.
c. Click Update to update the search expression in the Current Criteria box.

10. Click Search to begin searching. The results list appears.

Searching Branches

When you are searching for bibliographic and item records, you can choose which
branches you want Polaris to search, as well as which collections to search within each
branch. The Find Tool’s Branches tabbed page lists all the assigned branches, along
with their collections, in your library system. Searches for bibliographic records by
branch or collection return results based on the linked item records. If the bibliographic
record is not linked to any item records with that assigned branch, it does not appear in
the results list on the Branches tab. If the bibliographic record is not linked to any item
records with that collection, it does not appear in the results list on the Collections tab.
Bibliographic records without linked item records do not appear in the results list.

Important:

Search results, except for bibliographic titles and call number browse
searches, may be filtered so the results list includes only those results
that you have permission to access. If the Staff Client profile Find Tool:
Filter search results by permission is set to Yes, you will see only those
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records for which you have Access permission. For more information
about setting permissions in Polaris, see the Polaris Administration PDF
Guide, Setting Administration Permissions.

Tip:

If you want to find bibliographic records owned by a certain branch but
with no linked item records, do a Scoping search instead of a Branch
search. A branch search looks for bibliographic records with linked items
assigned to the branch. If no items are linked, the bibliographic record is
not found.

To search for bibliographic and item records by branch and by collection associated
with each branch:

Note:
You can search by branches only in normal search mode.

1. Onthe Find Tool - General tabbed page, fill in the Object, Search by, Type, and
For boxes (see Doing a Basic Search).

2. Click the Branches tab to display the Branches tabbed page.

By default, all branches and collections are selected.

Tip:
To search all branches, click Select All.

3. Click Unselect All to clear the checkboxes for all branches and collections.The
status bar displays BR to indicate that you are searching by branch.

4. If you want to search all the collections in a branch, select the checkbox next to
each branch to be searched.

5. If you want to search by particular collections in a branch, follow these steps:
a. Click the plus sign [+] next to the branch. The plus sign is replaced by a minus sign
[-]. All the collections for the branch appear.

b. Select the checkbox next to each collection you want to search. The checkbox
next to the branch is grayed out to indicate that one or more collections are not to
be searched within the branch.
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Tip:
To start a new search, click New Search. The General tabbed page
appears. To reset the list, click Reset.

6. Click Search to begin the search. The results list appears.

Related Information

When searching by branch and collection, you can also use other searching features.
See also:

o Write a Power Search Query
e Do a SQL search
e Scoping Searches for Bibs and ltems

Searching Collections

You can search for item records or bibliographic records by collection, but when you
search for bibliographic records by collection, the search is actually looking for the
linked item records with the selected collection. If the bibliographic record has no linked
items in that collection, the bibliographic record is not included in the results. The Find
Tool's Collections tabbed page lists all the assigned collections in the system, along
with their associated branches. You can search by collection and by the branches that
share the collection.

To search for bibliographic and item records by collection and by branch:

Note:
You can search using collections only in normal search mode.

1. Onthe Find Tool - General tabbed page, fill in the Object, Search by, Type, and
For boxes (see Doing a Basic Search).

Tip:

If you search for bibliographic records by collection, the search looks for
bibliographic records linked to item records in that collection.
Bibliographic records that are not linked to item records do not appear in
the results list.

2. Click the Collections tab to display the Collections tabbed page.

By default, all collections and the branches that use each collection are selected.
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Tip:
To search all collections, click Select All.

3. Click Unselect All to clear the checkboxes for all collections and their branches.
The status bar displays CO to indicate that you are searching by collection.

4. If you want to search all the branches that use a collection, select the checkbox
next to each collection to be searched.

5. If you want to search by particular branches associated with a collection, follow
these steps:

a. Click the plus sign [+] next to the collection. The plus sign is replaced by a minus
sign [-]. All the branches for the collection appear.

b. Select the checkbox next to each branch you want to search. The checkbox next to
the collection is grayed out to indicate that one or more branches that use the col-
lection are not to be searched.

Tip:
To start a new search, click New Search. The General tabbed page
appears. To reset the list, click Reset.

6. Click Search to begin the search. The results list appears.

Related Information

When searching by branch and collection, you can also use other searching features.
See also:

e Do a power sear